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NOTICE TO USERS

Ontrack® PowerControls™ is a software application that has been developed, copyrighted, and 
licensed by Kroll Ontrack Inc. Use of the software is governed by the terms and conditions of the 
end user license agreement contained within the software.

This manual should not be construed as any representation or warranty with respect to the software 
named herein. Occasionally, changes or variations exist in the software that are not reflected in the 
manual. 

Generally, if such changes or variations are known to exist and affect the product significantly, a 
release note or Read Me file will accompany the User Guide, or will be available on the Ontrack 
PowerControls web site. In that event, please read the release notes or Read Me file before using 
the product.

TRADEMARKS

Kroll Ontrack, Ontrack, PowerControls, and other Kroll Ontrack brand and product names referred 
to herein are trademarks or registered trademarks of Kroll Ontrack Inc., and/or its parent company, 
Kroll Inc., in the United States and/or other countries. All other brand and product names are 
trademarks of their respective owners.

Microsoft, Exchange, SharePoint, Windows and other Microsoft brand and product names referred 
to herein are either registered trademarks or trademarks of Microsoft Corporation in the United 
States and/or other countries.

All other brand and product names are trademarks of their respective owners.

COPYRIGHTS

Copyright © 2011 Kroll Ontrack Inc. All rights reserved.

Outside In Content Access © 1991, 2010 Oracle. All rights reserved.

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, 
or translated into a language or computer language, in any form by any means, electronic, 
mechanical, optical, chemical, manual or otherwise, without the express written consent of Kroll 
Ontrack Inc.

CONTACT INFORMATION

For contact information for our worldwide locations, see

http://www.krollontrack.com/contact-us/ 
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INTRODUCTION

INTRODUCTION

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

Welcome to Ontrack® PowerControls™ 6.1, the software that allows you to perform source and 
target functions on Microsoft® Office SharePoint® Server data, including opening, copying, 
exporting, restoring, and saving attachments. It also provides a robust search function on source 
items.

Ontrack PowerControls for SharePoint works with your existing SharePoint database, and allows 
you to restore content from MDF files, NDF files, and LDF files directly to your SharePoint target, 
or to a different SharePoint server. Content database backups can be extracted from tape or disk-
based backups using the Direct Method of extraction.

This user guide provides step-by-step instructions for completing specific tasks on the Microsoft® 
Windows®-based platform. See the Table of Contents or the Index to locate the pages on which 
particular topics are discussed.

Use Adobe® Acrobat® to open the PDF version of this user guide. After you open the PDF file, 
click the Hand tool to view the Table of Contents hyperlinks in layout view. Then click a hyperlink 
to jump to a specific topic in the manual.

Five Major Reasons for Using Ontrack PowerControls for 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Microsoft Office SharePoint Server

There are five primary ways you can benefit from using Ontrack PowerControls for SharePoint:

1. Minimizes the time to restore an individual document, item, list, folder, site, or library. 
Ontrack PowerControls for SharePoint can slash restore time, making it possible to granularly 
restore items from a previous full backup. Items from database backup can be restored individually, 
giving you restore flexibility and eliminating the need to perform to a full site restoration in order to 
find the items you need.

2. Eliminates same site restore constraint. By eliminating same site restore constraint, Ontrack 
PowerControls gives you the flexibility to restore to origination or alternate SharePoint locations. 
Ontrack PowerControls allows you to restore directly into your production SharePoint server or a 
file system. 

3. Minimizes the time to locate all matching specific criteria. Ontrack PowerControls includes 
an Advanced Find feature that can search across all content databases in an archive SharePoint file, 
rather than bringing an old backup back online for analysis. You can search by a variety of criteria, 
including keywords, subject, date, specific users, and file and attachment data.

4. Maintains data integrity of the SharePoint source. Ontrack PowerControls does not change 
the contents or metadata of the SharePoint source, and maintains data integrity of the SharePoint 
source by performing read-only operation.
Copyright © 2011 Kroll Ontrack Inc. 1



I N T R O D U C T I O N
Ontrack PowerControls 6.1 for SharePoint EnhancementsINTRODUCTION
5. Minimizes the costs involved in restoring lost items. Ontrack PowerControls for SharePoint 
eliminates the need to have an expensive restoration server available, as well as the cost associated 
with the extra steps required to separately import sites back into SharePoint to find items needed. 
Also, since it can read your existing content database backups, there is no need to purchase 
proprietary software for creating the backups. Your backup process can remain the way it is today.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Ontrack PowerControls 6.1 for SharePoint Enhancements

Ontrack PowerControls 6.1 for SharePoint provides support for: 

• Microsoft® Office 2010
• Microsoft® SharePoint 2007 content databases hosted on SQL Server 2008 R2.
• Microsoft® SharePoint 2010 content databases, including content databases with Remote 

BLOB Store (RBS) enabled, hosted on SQL Server 2008 SP1 Cumulative Update 2, SQL 
Server 2008 R2, and 64-bit SQL Server 2005 SP3.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
System Requirements

To use Ontrack PowerControls for SharePoint on your computer, you need the following hardware 
and software: 

• One of the following operating systems:
• Windows XP Professional
• Windows Server 2003 Standard
• Windows Server 2003 Data Center
• Windows Server 2003 Enterprise
• Windows Server 2008 Standard
• Windows Server 2008 Data Center
• Windows Server 2008 Enterprise
• Windows Server 2008 R2
• Windows Vista® Business
• Windows Vista Ultimate
• Windows Vista Enterprise
• Windows 7 Professional
• Windows 7 Enterprise
• Windows 7 Ultimate

Note:  The operating systems listed above are required to have the latest service packs 
installed.

Note:  32-bit and 64-bit versions of the above operating systems are supported.
2 Copyright © 2011 Kroll Ontrack Inc.
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. .I N T R O D U C T I O N
Installing Ontrack PowerControls
Note:  The HASP HL override key functionality does not work on Windows Vista, Windows 
Server 2008, Windows Server 2008 R2, and Windows 7 operating systems when using a 
remote desktop connection to the computer.

Note:  Microsoft® Office SharePoint™ Server 2010 source data cannot be copied to 
SharePoint Server 2007 targets.

• The following virtual environments are supported:
• VMware® Server 1.0x, 2.x
• VMware® Workstation v6.0x, v7.0 x for Windows
• Microsoft® Virtual Server 2005 R2
• Microsoft® Hyper-V™
• Microsoft® Hyper-V Server™ 2008
• Microsoft® Hyper-V Server™ 2008 R2
• Microsoft® Virtual PC 2007
• VMware® ESX/ESXi 3.5, 4.0, 4.1

Note:  Virtual operation of tape devices may have restrictions imposed by virtual operating 
systems.

Note:  HASP key operation is validated in environments that support USB attached devices 
and support the Kroll Ontrack-distributed HASP drivers only.

• Microsoft® Office SharePoint® Server 2007 up to SP2 data and Microsoft® Office 
SharePoint® Server 2010 data stored on Microsoft® SQL Server® 2005 up to SP3 or 
Microsoft® SQL Server® 2008 up to SP2 or Microsoft® SQL Server® 2008 R2.

• Microsoft® SharePoint 2010 content databases with RBS enabled and supported only 
through SQL Server 2008 SP1 Cumulative Update 2 / SQL Server 2008 R2 FILESTREAM 
provider.

• Microsoft® .NET Framework 3.5 SP1. System must have .NET Framework 3.5 SP1 
installed in order to function.

• Intel® Pentium® 4 class or higher compatible processor
• 1024 MB RAM minimum
• 200 MB of free hard disk space for the installation. More disk space will be needed for 

processing log files when opening an MDF file.
• Monitor with 800 x 600 or higher screen resolution
• USB port (for Ontrack PowerControls product licenses requiring HASP key dongle to run 

application)

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Installing Ontrack PowerControls

Follow these steps to install Ontrack PowerControls for SharePoint:

1. Turn off any disk utility or antivirus program running in the background.
2. Insert the Ontrack PowerControls CD-ROM into your CD-ROM drive.
Copyright © 2011 Kroll Ontrack Inc. 3



I N T R O D U C T I O N
Uninstalling Ontrack PowerControlsINTRODUCTION
3. The installation program automatically starts. If it does not: 
• For Windows Vista, Windows Server 2008, and later: Select Run on the Start/All 

Programs/Accessories menu, and type D:\autorun.exe or D:\bin\setup.exe, where D 
is the drive letter of your CD-ROM drive. Click OK.

• For Windows Server 2003 and earlier: Select Run on the Start menu, and type 
D:\autorun.exe or D:\bin\setup.exe, where D is the drive letter of your CD-ROM 
drive. Click OK.

4. Follow the on-screen instructions.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Uninstalling Ontrack PowerControls

You can uninstall Ontrack PowerControls for SharePoint by running the uninstall program.

1. Click Start and then click Control Panel.
2. In the Control Panel:

For Windows Vista, Windows Server 2008, and later: Click Uninstall a program under 
the Programs heading.

• Click Ontrack PowerControls 6.1, and then click Uninstall/Change.
For Windows Server 2003 and earlier: Click the Add or Remove Programs icon.

• Click Ontrack PowerControls 6.1, and then click Change/Remove.
• Click Yes when the confirmation dialog box appears.

3. Follow the on-screen instructions.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Keyboard Shortcuts

Menu Bar Keyboard Shortcut

File Menu

Open Source Ctrl+S

Open Target Ctrl+T

Open Item Ctrl+O

Close Store Ctrl+L

Use Wizard Ctrl+W

Exit Alt+F4

Edit Menu
4 Copyright © 2011 Kroll Ontrack Inc.
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. .I N T R O D U C T I O N
Keyboard Shortcuts
Copy Ctrl+C

Paste Ctrl+V

Select All Ctrl+A

View Menu

Refresh Screen F5

Tools Menu

Export Ctrl+P

Find F3

Help Menu

View Help Contents F1

Menu Bar Keyboard Shortcut
Copyright © 2011 Kroll Ontrack Inc. 5



I N T R O D U C T I O N
Ontrack PowerControls LicensingINTRODUCTION
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Ontrack PowerControls Licensing

Ontrack PowerControls software editions are licensed based on the number of configured 
SharePoint databases in your environment. The license is used for a customized number of 
databases for a specified period of time.

Ontrack PowerControls also offers a free edition with limited functionality. With this edition, you 
can search a SharePoint database as a source, and view items.

Technical Note: Ontrack PowerControls for SharePoint does not open more databases than 
originally licensed for.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Enabling the Licensed Agents

Each edition of Ontrack PowerControls software for SharePoint is distributed with two Ontrack 
PowerControls ExtractWizard Agents and one Ontrack PowerControls Agent for SharePoint. All 
other Agents are shipped with all Ontrack PowerControls editions in disabled conditions and 
require a new license file to be enabled. 

Ontrack 
PowerControls 

Edition

Ontrack 
PowerControls 

Feature
Agents Feature

Ontrack 
PowerControls 6.1 

Subscription 
enforcement

For Direct Method: ExtractWizard Agent 
included and partially enabled.

For Advanced Method: ExtractWizard Agent 
is not included and is disabled.

Agent for Advanced Searching for SharePoint 
(priced separately)

Agent for Native SharePoint Backups

Ontrack 
PowerControls 6.1 
Free

All features included 
and partially enabled 
(open any MDF file, 
view all content, 
search one source, 
copy none)

For Direct Method: ExtractWizard Agent 
included and partially enabled.

For Advanced Method: ExtractWizard Agent 
is not included and is disabled.

Ontrack 
PowerControls 

ExtractWizard Agent
Versions 

Supported Disk Backup Tape Backup

Agent for Native 
SharePoint Backups

STSADM and Site 
Administrator

.BAK Files Microsoft Tape 
Format (MTF)
6 Copyright © 2011 Kroll Ontrack Inc.
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. .I N T R O D U C T I O N
Upgrading Ontrack PowerControls
Note:  The Agent for Native SharePoint Backups does not support transaction log backups or 
differential backups.

In addition to Ontrack PowerControls ExtractWizard Agents, Ontrack PowerControls users also 
have the option to purchase other unique add-on features for enhanced search and analysis 
capabilities for SharePoint.

To view the currently enabled Agents 

• On the Help menu, select About and then select License Info.

To enable an Agent 

1. Contact a sales representative and specify which agent you want to purchase. A license file 
containing the newly enabled agent will be sent to you. 

Note:  To contact a sales representative, see Contact Information.

2. Replace the existing .ini file with the new .ini file. The default location for this file is in the 
Ontrack PowerControls directory. 

The License File

All Ontrack PowerControls editions for SharePoint require a license file. The purpose of this file is 
to let you buy only those features you need. Before Ontrack PowerControls for SharePoint is 
enabled, it checks the .ini file for four things:

• The license file must be valid for Ontrack PowerControls 6.1. 
• Database enforcement, if applicable. 
• Subscription length, if applicable.
• Enabled Agents (Ontrack PowerControls ExtractWizard Agents and Ontrack 

PowerControls Agents for SharePoint)

Note:  To view and/or change the location of the license file, see “Setting Preferences” on page 23. 
In the Preferences window, see the instructions for the “License file name” preference.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Upgrading Ontrack PowerControls

If a previous version of Ontrack PowerControls has been installed, is active, and you are upgrading 
to Ontrack PowerControls 6.1, you will not be able to reuse the existing Ontrack PowerControls 
license file with Ontrack PowerControls 6.1. 

Ontrack PowerControls Agent

Agent for Advanced Searching for SharePoint
Copyright © 2011 Kroll Ontrack Inc. 7



I N T R O D U C T I O N
Getting HelpINTRODUCTION
Upgrading Ontrack PowerControls when Kroll Ontrack Administrative Server is Required

If the Kroll Ontrack Administrative Server (KOAS) is required either through the use of the Agent 
for Administrative Services or for the Central Licensing Service (CLS), before upgrading Ontrack 
PowerControls, it is necessary to first upgrade your KOAS server and optionally configure CLS to 
use your new Ontrack PowerControls 6.1 CLS license. Please see the KOAS user documentation 
for details on how to perform an upgrade installation. 

To upgrade site installations requiring KOAS when CLS is in use

1. Close all Ontrack PowerControls clients.
2. Upgrade the previous version of KOAS to KOAS 6.1.
3. Start the KOAS management console to verify KOAS has upgraded.
4. Using the KOAS CLS plug-in, in the License File tab, configure KOAS CLS to use the 

Ontrack PowerControls 6.1 CLS license file provided with the delivery of Ontrack 
PowerControls 6.1 and KOAS 6.1.

5. Follow the instructions and restart KOAS to ensure that CLS is running properly. If the 
wrong CLS license file is configured, an error displays in the CLS status displays.

6. Use the existing Ontrack PowerControls installation.

Note:  Previous Ontrack PowerControls installations can be upgraded to Ontrack 
PowerControls 6.1 as required.

To upgrade site installations requiring KOAS when CLS is not in use

1. Close all Ontrack PowerControls clients.
2. Upgrade the previous version of KOAS to KOAS 6.1.
3. Start the KOAS management console to verify KOAS has upgraded.
4. Use existing Ontrack PowerControls installation.

Note:  Previous Ontrack PowerControls installations can be upgraded to Ontrack 
PowerControls 6.1 as required.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Getting Help

Kroll Ontrack provides you with the following ways to get help with Ontrack PowerControls: 
“Online Help” and “Technical Support”.

Online Help

Online Help includes all of the information in the user guide and more, and lets you quickly access 
this information by using one of three tabs. The Contents tab offers a hierarchical view of the 
contents of the user guide. The Search tab offers a full-text search of the user guide. The Index tab 
offers a keyword-based way to get to specific topics.

To start online Help

Do one of the following:

• On the Help menu, select Contents.
8 Copyright © 2011 Kroll Ontrack Inc.
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. .I N T R O D U C T I O N
Conventions in this Manual
• Click  on the toolbar.
• Press the F1 key.

To identify a tool or control

• Position the pointer over a tool or control, and then pause. A tool tip shows the name of the 
item.

Technical Support

If you have questions or problems not answered in the user guide or the online Help (F1), call our 
Technical Support group. When reporting an issue, please include any information that might help 
us diagnose the problem. The following details are often the most helpful:

• The version of Ontrack PowerControls you are using (on the Help menu, select About).
• The versions of Windows operating systems that you are running.
• The version of SQL Server that contained the source database file.
• The version of SharePoint Server for the source data.
• The version of SharePoint Server for the target.
• The circumstances and sequence of steps that led to the problem.
• The text of the error messages (if any appeared), and the contents of the Details window.
• A list of other Windows-based programs that you were running when the error occurred.

See “Contact Information” at the beginning of this user guide.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Conventions in this Manual

This manual uses guidelines for commands available on shortcut menu and notes and tips. 

Shortcut Menu

You can access many of the same commands available on the menu bar and toolbar by right-
clicking the mouse to display a shortcut menu. The contents of the shortcut menu depend on 
whether you right-click in the source or target pane. This manual seeks to teach you how to use 
commands on the menu bar and toolbar, and doesn’t always specify when you can use the shortcut 
menu. Once you become familiar with Ontrack PowerControls, the commands available to you on 
the shortcut menu should become apparent.

Notes and Tips

The notes and tips in this user guide follow the guidelines offered in the Microsoft Manual of Style 
for Technical Publications, 3rd Edition. Redmond, WA: Microsoft Press, 2004.
Copyright © 2011 Kroll Ontrack Inc. 9
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CHAPTER 1

. . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
LOOKING AT THE INTERFACE CHAPTER 1 : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

This section describes the parts of the main window of Ontrack® PowerControls™ for SharePoint, 
details the function of the tool bar and each pane and menu, and explains how to customize the 
window. 

It also describes on a high level how SharePoint content database files can be opened as one or 
more sources; how the source is displayed in a tree view and mimics the hierarchy in the 
SharePoint database; and how the source data for lists is displayed with customized column 
headings depending on the data type.

This section also describes on a high level how Ontrack PowerControls can connect to a SharePoint 
Server as target, how Ontrack PowerControls can open one or more targets and display the target as 
a tree view mimicking the hierarchy in the SharePoint Server, and how the target data for lists is 
displayed in the list pane with customized column headings depending on the data type.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Main Window

The main window of Ontrack PowerControls for SharePoint is where you do most of your work. 
The main window is divided into four panes by two split bars: the two source panes above the two 
target panes. 

The source panes display the source MDF, NDF, and LDF file(s). The left source pane contains the 
SharePoint content database tree view. When you select an item in this pane, its contents appear in 
the right source pane.

The target panes act as a container for the restored items on the target server. The left target pane 
contains the SharePoint nodes and contents copied, dragged and dropped, or added through the 
Data Wizard. The right target pane displays the list of the contents of the item selected in the tree 
view on the left target pane.

Any functions that can be performed on a source data item or target items can be accessed through 
the menu bar, the toolbar, or the right-click context menus.
Copyright © 2011 Kroll Ontrack Inc. 11



L O O K I N G  A T  T H E  I N T E R F A C E
Main WindowCHAPTER 1
Figure 1-1. The main window with its four panes

Menu Bar

Figure 1-2. The menu bar in the main window

The menu bar contains all of the commands for Ontrack PowerControls for SharePoint. The menu 
commands, submenu commands, and resulting dialog boxes are discussed fully in the sections that 
focus on those specific commands.

Toolbar

Figure 1-3. The toolbar in the main window

The buttons on the toolbar perform the following functions:

Open Source opens the Source Path Selection page of the Data Wizard, where you 
can add .mdf, .ndf., and .ldf files.

Open Target opens the Target Server Selection page of the Data Wizard, where you 
can enter the target SharePoint server name, configuration database, and 
authentication.

Copy copies onto the clipboard the selected item(s) in the source list or list and 
folders from the tree view. 
12 Copyright © 2011 Kroll Ontrack Inc.
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. .L O O K I N G  A T  T H E  I N T E R F A C E
Main Window
Icons in Tree Views

In the source and target panes, the root nodes, sites, lists, and folders have individualized icons. 
Any list type without an assigned icon uses a default icon .

Note:  Not all lists for a site are shown in the list. If certain lists contain system information, they 
may not be shown.

Figure 1-4. Sample icons with descriptions below 

Paste inserts the items from the clipboard into the selected list or folder in the target 
pane. 

Export displays the Export Options page of the Export Wizard, which lets you 
export an item to a local or network drive destination. 

Find displays the Find in Sources dialog box, which lets you specify the desired 
search criteria for finding items in the source pane.

View Help displays Ontrack PowerControls for SharePoint Online Help, which 
includes all of the information in this user guide and more. Online Help lets you 
quickly access this information by using a Contents, Search, or Index tab.

Kroll Ontrack on the Web takes you to the Kroll Ontrack web site 
(www.krollontrack.com), providing you with additional information on products and 
services by Kroll Ontrack.

Sources contains one or more source data stores. You can select the sources root 
node as your search source.

Targets contains the target SharePoint server databases for connection as a target.

Source Root Node contains the .mdf, .ndf, and .ldf files. Click the plus sign (+) next 
to a node to expand its contents.
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Target Root Node contains the target SharePoint server. Click the plus sign (+) next 
to a node to expand its contents.

Site contains the site/site collection nodes lists. Click the plus sign (+) next to a node 
to expand its contents.

Default icon for List objects, custom lists, and Datasheet

Document Library, Form Library, Wiki Page Library are Web Parts that 
organize documents by department, project, or by topic.

Folders can be created within Web Parts to organize documents or lists.

Discussion Board can contain Web discussion notes between users of the site.

Agenda can contain information that meeting attendees need to have access to in 
advance of a meeting.

Calendar is a view of the events list after recurring events have been added.

Text Box can be created within a Web Part to just contain text.

Surveys can contain various forms of surveys: online surveys, email-based surveys, 
and database-driven surveys.

Contacts, Attendees are lists that contain contacts for the users of the site including 
phone numbers, email addresses, and other information.

Picture Library, Report Library are Web Parts similar to Document Libraries 
which store documents and allow users to attach metadata to the documents.

Data Connection Libraries are Web Parts similar to Document Libraries which 
store documents and allow users to attach metadata to the documents.

Slide Libraries are Web Parts similar to Document Libraries which store documents 
and allow users to attach metadata to the documents.

Translation Library, Languages, and Translators are the list of languages to 
assign to translation tasks and any translators specified for each language.

Announcements is a Web Part in SharePoint and contains any announcements 
entered by a Site Administrator.

Links is a Lists Web Part that provides easy access to web sites.

Tasks is a Lists Web Part used for managing tasks within a project.

Project Tasks, Issue Tracking are used to track issues based on different categories 
added by the Site Administrator.

Decisions is a list created from a template within a Meeting Site in SharePoint.
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Source Panes

The source list displays the SharePoint content database files that you selected in the Source Path 
Selection page of the Data Wizard. The source tree can display one or more sources. It displays the 
source as a tree view and mimics the hierarchy of the SharePoint database.

Figure 1-5. The source tree view of a SharePoint database

For more information on using the source panes, see “Data Wizard: Source Path Selection Page” on 
page 26.

SOURCE ITEM LIST

The source item list displays the source items in a list with columns depending on the type of 
source list. The columns can include leaf name; attachments, if any; title; content type; UI Version; 
modified and created on dates; created by; and modified by. 

Things to Bring contains lists in the Lists Web Part.

Datasheet is a view within a library or list that requires Microsoft Excel to open.

KPI List contains Key Performance Indicator lists in the Lists Web Part.

(This is appears as Status List in SharePoint 2010).

Circulations contains lists that track to track the flow of documents in a Group Work 
list (SharePoint 2010 only).

IME Dictionary List contains data used in a list as a Microsoft Input Method Editor 
(IME) dictionary (SharePoint 2010 only).
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Figure 1-6. Source Data List

You can open a source data list item using the native application with which it was created by right-
clicking on the item and selecting Open File in the context menu. If the native application for the 
item is not available on your computer, a dialog box appears allowing you to select the application 
to view the item data. If you want to view the metadata of an item that can be opened with the 
native application, right-click and select Open Item.

Source Data List Context Menu

Source list items have several functions available through a context menu. You can right-click on 
an item or multiple items to display a context menu with the following options available: 

• Open Item: Displays the metadata of an item in a new dialog box or open the native 
application.

• Open File: Open File is available if the item has a content stream. Only one item can be 
selected at a time.

• Copy: Copies the selected item or items to the clipboard.
• Select All: Selects all of the items in the list.
• Export: Opens the Export Wizard and allows you to save the selected item to a selected 

location.
• Save Attachments: Displays the Save Attachment dialog box and allows you to save the 

attachments of the selected item to a selected location.
• Previous Versions: Displays the Previous Versions dialog box and allows you to view the 

previous versions of the item and copy them to a selected location or to the target pane.
Some context menu items are unavailable when multiple items are selected; for example, “Open 
Item,” “Open File,” “Save Attachments,” and “Previous Version” functions.

For more information on all of these functions, see “Using Ontrack PowerControls for SharePoint” 
on page 25.

Target Panes

Ontrack PowerControls can connect to target SharePoint servers. One or more targets can be 
opened at a time. The target data is displayed in a tree view which mimics the hierarchy of the 
SharePoint database.
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Figure 1-7. Target Tree View

TARGET ITEM LIST

The target item list displays the target items in a list with columns depending on the type of target 
list. The columns can include leaf name; attachments, if any; title; content type; UI Version; 
modified and created on dates; created by; and modified by.

Figure 1-8. Target Data List 

You can open a target data list item using the native application with which it was created by right-
clicking on the item and selecting Open File in the context menu. If the native application for the 
item is not available on your computer, a window is displayed to allow you to select the application 
to view the item data. If you want to view the metadata of an item that can be opened with the 
native application, right-click and select Open Item. See “Opening Items” on page 30 for more 
information.
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Figure 1-9. Open Item metadata

Note:  Not all the data about an item is displayed in the list. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Changing the View

You can change the view in the Ontrack PowerControls window by hiding the toolbar or status bar, 
adjusting split bars; sorting lists; and refreshing the screen.

Viewing or Hiding the Toolbar and Status Bar

The toolbar and status bar appear by default in the main window, but you can easily hide them.

To hide the toolbar or status bar

• On the View menu, select Toolbar or Status Bar. The check mark no longer appears next 
to the name of the toolbar or status bar.
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To view the toolbar or status bar

• On the View menu, select Toolbar or Status Bar. The check mark appears next to the name 
of the toolbar or status bar.

Resizing Panes Separated by a Split Bar

You can use a split bar (the horizontal or vertical double line that separates two panes) to increase 
the area within one pane while simultaneously decreasing the area within the adjacent pane. 

To resize panes separated by a split bar

1. Position the cursor over a split bar between the two panes until a double arrow  appears. 
A vertical double arrow  appears if you position the cursor over a horizontal split bar.

Figure 1-10. Resizing the split bar between the source and target list as well as the tree view 
pane from the list pane

2. Drag the split bar until the two panes are the desired size.

Arranging Columns in the Items List

You can arrange the columns in the source and target items list by dragging and dropping the 
column headers. You can add or remove columns by right-clicking on the column header to display 
the Arrange Columns context menu. 

Figure 1-11. Arrange Columns context menu
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Selecting Arrange Columns displays the Arrange Columns dialog box.

Figure 1-12. Arrange Columns window

To arrange columns horizontally

1. Select one or more items in the Available list and click Include>. The item(s) appear at the 
bottom of the Current list.

2. To include all of the Available list items in the Current list, click Include All>>.
3. To exclude all of the Current list items in the Available list, click <<Exclude All.
4. To set the lists to the default setting, click Reset.
5. Click OK.

Note:  At least one column must remain in the Current list to exit from the Arrange Columns 
window.

To arrange columns vertically

1. To arrange the order in the Current list, select one item at a time and click Move Up or 
Move Down. The list appears in this order from left to right in the source or target list view.

2. To set the lists to the default setting, click Reset.
3. Click OK.

Sorting Items in the Items List

You can sort items in the source and target lists based on any column.
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To sort a list

1. Click a column heading to sort the items based on that heading. For most headings, an 
arrow appears indicating the sort direction. An up arrow indicates that the items appear in 
ascending (A-Z) order. A down arrow indicates that the items appear in descending (Z-A) 
order.

2. To reverse the order of the items based on that column heading, click the column heading 
again. Notice the arrow reverses directions.

An example of sorting items

• If you click the attachment  column heading, items are sorted in descending order 
based on this heading, even though no arrow appears. This means that items with 
attachments appear at the bottom of the list, while items with no attachments appear at the 
top of the list. If you click the attachment  column heading again, the order is reversed.

Note:  The view settings (sort order and column width) for a folder or list are saved until you close 
the data store.

Refreshing the Screen

You may want to refresh the screen occasionally when you are connected to a live target SharePoint 
server. That is because the information on the server may change while you are connected.

To refresh the screen

Do one of the following:

• On the View menu, select Refresh.
• Press the F5 key.
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Viewing the Properties of a SharePoint Content Database

Ontrack PowerControls makes it easy to view the properties of a SharePoint content database file.

To view the properties

1. In the source pane, right-click a SharePoint content database file.
2. On the shortcut menu, select Properties. A Properties window appears.

Figure 1-13. MDF File Properties

You can save the GUID by clicking the Save GUID button and directing the text file to your desired 
location.
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Setting Preferences

The Preferences dialog box allows you to streamline Ontrack PowerControls for SharePoint 
operations. 

To change preference settings 

1. On the Edit menu, select Preferences.
2. Select or clear the check boxes, as desired.

Figure 1-14. The Preferences dialog box

• Run Data Wizard on startup: When this option is selected, the Data Wizard launches 
every time you open Ontrack PowerControls.

• Show warning when no log files specified: When this option is selected, Ontrack 
PowerControls warns you when opening a file if an .ldf file path has not been specified.

• Check for duplicates during copy: When this option is selected, two forms of 
duplicate checking will occur depending on the type of item that is being copied. In 
either method, if an item is a duplicate and you choose to overwrite, the existing item is 
removed and the new item is added. See “Duplicate Checking” on page 52 for more 
information.

• License file name: This box displays the current location of the license file. To save 
this file in a different location, click Browse (...) and navigate to the desired location. 

Note:  For more information about the license file, see “The License File” on page 7.
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USING ONTRACK POWERCONTROLS FOR 

. . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
SHAREPOINT CHAPTER 2 : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

You can open a source MDF file or NDF file and specify a target SharePoint server using the Data 
Wizard. You can also open the source database and target SharePoint server from the main window, 
as well as open a source database with the command line.

Before You Use Ontrack PowerControls for SharePoint
Use Ontrack PowerControls ExtractWizard if you have not yet restored backed-up data. The 
Ontrack PowerControls ExtractWizard reads previous SharePoint backups and restores files to any 
machine, volume, or folder. For more information, see the Ontrack PowerControls ExtractWizard 
User Guide.

Opening the Source Database and Target Servers with the 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Data Wizard

The Data Wizard guides you through the loading of the MDF, NDF, and LDF files into Ontrack 
PowerControls, and shows you how to specify the target SharePoint server.

Data Wizard: Welcome Page

The first time you start Ontrack PowerControls, the Data Wizard launches. 

To manually start the Data Wizard

1. Click Start, and then point to Programs. Point to Kroll Ontrack, then Ontrack 
PowerControls, and select Ontrack® PowerControls™ for SharePoint. The Data 
Wizard appears. 

Note:  If you do not want to run the Data Wizard every time you start Ontrack 
PowerControls, clear the Show wizard on startup check box.

2. Click Next. The Source Path Selection page appears.
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Data Wizard: Source Path Selection Page

Use the Source Path Selection page of the Data Wizard to specify the source MDF, LDF, and NDF 
file paths and the temporary file path. If you do not want to open a source MDF, NDF, and LDF file 
at this time, click Skip.

To specify a source file

1. In the Source Files group, do one of the following:
• Click Add and use the Open dialog box to find the source .mdf file, .ndf file, and .ldf 

files 
-or- 

• Open Windows Explorer and drag and drop the source files from their location onto the 
Source Files box.

Important:  Verify that the log files and database files were created in the same backup.

Important:  If your source content database contains an NDF file, it must be included with 
the MDF file.

Note:  Multiple files can be added to the Source Files box and are listed in the order they 
were added, however, only a single content database can be opened.

Note:  If you want to remove files from the Source Files box, select the file and click 
Remove.

2. In the Temporary File Path box, accept the default location for the .idx and .dat files or, if 
the files require more hard drive space, specify a new location by clicking Browse (...). 

Figure 2-1. Temporary File Path selection

3. Click Next. The Target Server Selection page appears.

Data Wizard: Target Server Selection Page

Use the Target Server Selection page of the Data Wizard to enter the information to connect to the 
server running Microsoft Office SharePoint Server you are using as the target for your restored 
data. If you do not want to select a target at this time, click Skip.

To specify a server running Microsoft Office SharePoint Server as the target for restored data

1. In the SharePoint Server Site URL box, do one of the following:
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• Enter the URL of the server running Microsoft Office SharePoint Server you are using 
as the target

-or- 
• Use the drop-down arrow to select a previously used target.

2. In the Agent for Content Transfer Service Port number, enter the service port number.
3. If credentials are required to access the web service, select Credentials required to 

access the web service, in the Authentication group to enable the Username, Password, 
and Domain boxes.

4. If a User Principal Name is required to for Kerberos authentication, select User 
Principal Name (UPN) required for Kerberos authentication to enable the UPN box and 
enter the user name of the account running the agent for content transfer on the server 
(example format: user@domain.local).

5. Click Finish. 

Remote Blob Store Configuration (Filestream Provider)

When you attempt to open a source, Ontrack PowerControls checks if Remote Blob Store (RBS) is 
enabled and if Filestream is in use. If both are true, the Remote Blob Store Configuration dialog 
box appears, prompting you to select the RBS filestream files (filestream.hdr).

To select the RBS filestream configuration files

1. On the Remote Blob Store Configuration dialog box, click Add and use the Open File 
dialog box to select the RBS filestream files (filestream.hdr) for this database.

Note:  You can remove a filestream.hdr from the File box by clicking Remove.

2. Click Ok.

Results of Data Wizard

When you complete the Data Wizard, the source panes in the main window display a source 
content database (which contains an MDF file, 1 or more LDF files, and 0 or more NDF files) and 
the target panes display a target SharePoint server.

Important:  If your source content database contains an NDF file, it must be included with the 
MDF file.

Figure 2-2. Source panes with a source content database
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Figure 2-3. Target panes with a target SharePoint server

Returning to the Data Wizard

When working in the main window you can return to the Data Wizard at any time.

To open the Data Wizard from the main window

• On the File menu, select Use Wizard.

Opening the Source Database and Target Servers from the 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Main Window

Instead of running the entire Data Wizard, you can access the Source Path Select page or the Target 
Server Selection page from the main window.

Opening Source or Target Files

You can access the Source Path Select page to open the source databases or the Target Server 
Selection page to open target servers from the main window. These two pages are identical to those 
on the Data Wizard, with the Next button replaced with a Finish button.

To open a source file

1. Do one of the following:
• On the File menu, select Open Source.
• On the toolbar, click the Open Source icon .
• Press Ctrl+S
• Drag and drop a single MDF file into the source tree pane of the main window. 

2. Complete the Source Path Selection page.
For information about how to complete the Source Path Selection page, see “Data Wizard: 
Source Path Selection Page” on page 26.

3. Click Finish. 
Depending on your configurations, you may need to complete the Remote Blob Store 
Configuration dialog box. For more information, see “Remote Blob Store Configuration 
(Filestream Provider)” on page 27.
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To open a target

1. Do one of the following:
• On the File menu, select Open Target.
• On the toolbar, click the Open Target icon .
• Press Ctrl+T

2. Complete the Target Path Selection page.
For information about how to complete the Target Path Selection page, see“Data Wizard: 
Target Server Selection Page” on page 26.

3. Click Finish.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Opening the Source Database from the Command Line

In addition to using the Data Wizard or main window, a third method to open the source databases 
is with the command line.

To To open the source database with the command line

1. Open the command line.
2. Type the location of Ontrack PowerControls installation files, followed by 

PC.SharePoint.exe.
3. Append this with the temporary file path and/or the source file names as parameters.

• Every source file name must be prefixed with the keyword -sourcefile and bracketed 
within double quotes. 

• The prefix and the file name must be separated with a space.
• The temporary file path must be prefixed with -t keyword and bracketed within double 

quotes.
• The prefix and the temporary file path name must be separated with a space.
• If the database uses RBS filestream, specify the location of the .hdr files prefixed with 

-rbsfilestream and bracketed within double quotes. 
• The prefix and the file path name must be separated with a space.

4. Press Enter.
• If the “Show wizard on startup” box is selected on the Data Wizard, Ontrack 

PowerControls for SharePoint opens the Data Wizard at the Welcome to the Data 
Wizard page. The command line content will appear on the Source Path Selection page 
when you navigate to that page.

• If the “Show wizard on startup” box is cleared on the Data Wizard, Ontrack 
PowerControls for SharePoint opens the Data Wizard at the Source Path Selection page 
with the command line content displayed.

• In both cases, information entered from the command line appears on the Source Path 
Selection page.

• If the -rbsfilestream prefix is used, the specified files will appear in the Remote Blob 
Store Configuration dialog box during the source open process.
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Opening Multiple Sources and Targets

You can display multiple sources in the source pane and multiple targets in the target pane. See the 
instructions for using the Data Wizard or the main window to open one source or one target at a 
time.

Figure 2-4. Multiple sources can be displayed

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Opening Items

You can view an item’s metadata from the source list, target list, search results, or the Previous 
Versions window. You can then launch the file directly from the metadata window if that file is 
available (for example, items in a document library) and the native application of the file is 
installed on your computer. Attachments can also be viewed with the native application of the file. 

You can also open a file directly from the main window without going through the metadata 
window. Only one item can be opened from the list at a time.

Note:  You can view the metadata of any type of item in the list. However, not every item can be 
launched because of the type of item, the availability of the file itself (for example, items in a 
document library), or the availability of the native application on your computer.

Note:  Temporary files are created when file items are opened and then are cleaned out when 
Ontrack PowerControls for SharePoint is exited. However, any files still open in their native 
application when you exit are not cleaned out. If this temporary location ever becomes full, you will 
not be able to open items.

To open an item’s metadata

1. In the source or target list, right-click an item and select Open Item, or highlight and select 
Open Item from the File menu. The item’s metadata is displayed.

Multiple Targets

Multiple Sources
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Figure 2-5. Metadata for an item

• The title of the window is the leaf name and the version number of the item.
• The path to the file is displayed below the menu bar.
• In source items, the File menu provides options to open or save attachments or open the 

file.
• The Tools menu, available only in source files, provides the option to view any 

previous versions of the file.
• In target items, the menu bar provides options to open or save attachments, or open the 

file.

Opening the File

After viewing the item’s metadata, you can open the file directly from the Open Item metadata 
window if the Open File option is enabled. You can also open it from the main window.

To open the file 

1. Do one of the following:
• In the source or target list, right-click the item and select Open File, or highlight the 

item and select Open File from the File menu.
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• In the Open Item metadata window, select the File menu and select Open File.

Note:  Files cannot be opened without the native application of the file being installed on 
your computer. 

Note:  If the file is a ghost document and not the actual document in your SharePoint site, it 
may not be available to open.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Saving Attachments

A save attachments option is available on the File menu and the Attachments submenu of an open 
item. The Save Attachments dialog box lists the attachments for the selected item and lets you 
select the attachments you want to save. 

To save attachments in an open item

1. In the list item with a paperclip icon, do one of the following:
• On the File menu, select Save Attachments.
• Right-click the item and select Save Attachments in the context menu.

2. In the Save Attachments dialog box, select one or more attachments. 

Figure 2-6. Save Attachments dialog box

3. To Save To a different location, click Browse (...).
4. In the Browse For Folder window, select a location for the attachment(s), and click OK.
5. Click OK in the Save Attachments dialog box.
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Previous Versions in Source

You can open all previous versions of a source list item one at a time. These list items can be 
opened, copied, or exported, and the attachments can be saved.

To open previous versions of a list item

1. Do one of the following:
• Highlight the list item, select the Tools menu, and select Previous Versions.
• Highlight the list item, right-click and select Previous Versions.

2. In the Previous Versions window, open the item’s metadata, open file, copy, or export any 
item by using the menu or right-clicking the item. Save Attachments is enabled on items 
containing an attachment.

Figure 2-7. Previous versions of a source item

Note:  

• See “Exporting SharePoint Data” on page 45 for exporting instructions.
• See “Saving Attachments” on page 32 for instructions on saving attachments.
• See “Restoring SharePoint Data” on page 49 for copying instructions.
• SharePoint only stores the attachments of the most recent version of an item. If an 

attachment of a previous version is removed, it will not be shown in the Previous 
Versions dialog.

Closing Sources and Targets

You can close sources and targets from the main window.

To close a source

1. In the source pane, select a source SharePoint content database file.
2. Do one of the following:

• On the File menu, select Close Store.
• Right-click the selection, and on the context menu, click Close Store.
• Press Ctrl+L
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To close all stores

1. Do one of the following:
• In the source or target pane, right-click the root node, and click Close All Stores.
• On the File menu, select Close All Stores.

To close a target

1. In the target pane, select target SharePoint server file.
2. Do one of the following:

• On the File menu, select Close Store.
• Right-click the selection, and on the context menu, click Close Store
• Press Ctrl+L
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SEARCHING ON SHAREPOINT 

. . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
SOURCES CHAPTER 3 : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

The Find in Sources window enables you to search source SharePoint content databases for items 
that are defined by such criteria as keywords, creators and modifiers, and item creation and 
modification dates. In addition, this window lets you define the scope of your search: in one or 
more content databases, sites, lists, folders, or even previous search results.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Guidelines for Using the Find Window

The following guidelines will assist you in your search and analyzing the results.

• Ontrack® PowerControls™ can search multiple SharePoint databases at the same time. In 
the Find in Sources window, click Browse and you will see a tree view of all of the open 
source data stores. You can then select multiple sites or folders to include in your search.

• Previous versions of an item are not searched.
• Only a single search window can be open at a time.
• The Find Now button only becomes available if at least one of the following conditions is 

met:
• No search is in progress.
• All items or a specific item type is selected in the Search for item type OR Custom 

item types is selected and the custom item type box contains at least one character.
• The Search for words or Exclude words box contains at least one character.
• The Created by box contains at least one character.
• The Modified by box contains at least one character.
• The Created after or Created before check box is selected.
• The Modified after or Modified before check box is selected.
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• Each Search in drop-down selection that you select is run as a separate query, and the 
results of the query are combined (that is, OR’d together). For example, if you enter 
“solution” in the Search for words box, and then select the Item Data and File Data 
option, Ontrack PowerControls for SharePoint will return items that contain “solution” in 
either the item data or file data.

• If you don’t specify the Search for words or Exclude words, all items will be returned as 
hits unless other criteria are provided. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Searching Sources

You can use the Find in Sources window to search single or multiple databases and perform actions 
on the search results. 

You can open, copy, export items, or save attachments on search results. 

Opening the Find in Sources Window

In the source tree view pane, selecting the sources node, source node, site, list, or folder you want 
to search enables the Find submenu and the Find icon  in the toolbar. The item(s) you select 
defines the scope of your search.

To open the Find in Sources window

1. Select the item you want to search.
2. Do one of the following:

• Click Find  in the toolbar to display the Find in Sources window. The name of the 
folder you selected appears next to the Search in box

• Right-click the folder and click Find
• On the Tools menu, select Find
• Press F3.

Note:  The first time you search for an item, the Search in option is automatically selected. 
For information on using the Search in results option, see “Searching Within Results” on 
page 40.

The Find in Sources window is displayed.
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Figure 3-1. The Find in Sources window

3. To search multiple sites, lists, or folders, click Browse (...) next to the Search in path. In the 
Select Location(s) window, select the items you want to search. 

Figure 3-2. You can select multiple data stores to search.
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Note:  If you select the Search Subfolders check box, Ontrack PowerControls for 
SharePoint includes subfolders in the search.

4. Click OK to return to the Find in Sources window.
In the following illustration, the Search in box now displays “Multiple locations selected.”

Figure 3-3. Result when multiple items are selected

Selecting the Item Type(s)

The Search for item type drop-down list initially provides two options, All Items and Custom. The 
entire list of possible item types can be lengthy. If you want to search all items or enter in your own 
custom items, you can bypass this list. However, if you want to select item types from the list, you 
can click the Load Item Types button and the entire list populates the Search for item type drop-
down list.

To select the item types

1. In the Search for item type box, do one of the following: 
• All Items: Leave All Items as the default if you want to search all items in the 

SharePoint source, OR
• Custom: Select Custom in the drop-down list to manually enter item types in the 

Custom item types box you want to be searched, separated by a comma, OR
• Load Item Types button: If you have used the load item types button, the list will 

contain all of the item types present in the source databases. You can select the specific 
type for which you are searching.
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Note:  If another source is searched and the Load Item Types button is clicked, those item 
types are added to the drop-down list.

Narrowing the Scope of the Search

You can narrow down the scope of your search by entering keywords to search for and enter any 
keywords that should be excluded. You can select what type of data to search in: Item Data; Item 
Data and File Data; or Item Data, File Data, and Attachments. 

To narrow the search down further, you can enter the person who created the item and/or the person 
who modified it at some point. You also have the option of searching within a certain range of 
dates.

1. In the Search for words box, enter one or more words or phrases if you want to execute a 
keyword search. Keep in mind the following points:

• Put a space between words or phrases to perform an AND operation (that is, all words 
must be matched in order to include a item with the search results).

• Put a comma between words or phrases to perform an OR operation (that is, only one of 
the words must be matched in order to include a item with the search results).

• Put quotation marks around word phrases (that is, the exact phrase must be matched in 
order to include a item with the search results).

Example:Search for words: dog cat mouse, rat

Search results: Items that contain [“dog” AND “cat” AND “mouse”] OR [“rat”] are 
included in the search results.

2. In the Exclude words box, enter words or phrases if you want to perform a NOT operation. 
If matched, these words or phrases will exclude the item from the search results. The rules 
for using spaces, commas, and quotation marks apply when excluding words from a search.

Example:Search for words: dog cat mouse, rat

Exclude words: bird

Search results: Items that contain [“dog” AND “cat” AND “mouse”] OR [“rat”] BUT 
NOT [“bird”] are included in the search results.

3. In the Search in box, select one of the following from the drop-down list: Item Data; Item 
Data and File Data; or Item Data, File Data, and Attachments. 

Note about searching within file data or attachments: Ontrack PowerControls for 
SharePoint does not search within archive file types such as .zip or .rar files. For more 
information, see “Searching Within File Data or Attachments” on page 42.

4. In the Created by and Modified by boxes, enter the appropriate names, if desired. The 
rules for using spaces, commas, and quotation marks apply when using the Created by and 
Modified by boxes.

5. For Created after and Created before or Modified before and Modified before, select 
the appropriate check box, if desired. You may select both check boxes. Then type or select 
the part of the date you want to change.

• Created after: Searches for items created on or after the selected date.
• Created before: Searches for items created on or before the selected date.
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• Modified after: Searches for items modified on or after the selected date.
• Modified before: Searches for items modified on or before the selected date.

6. When you have finished specifying the search criteria, click Find Now. The results of your 
search appear in the item list.

Figure 3-4. Find in Sources window with results

Searching Within Results

The Search in results option lets you refine the search process using the previous search results.

To search within results

1. To make the Search in results option available, you must perform at least one search. 
2. Modify the search criteria as desired. For information on specifying search criteria, see 

“Searching Sources” on page 36.
3. Select the Search in results option at the top left of the Find in Sources window.
4. Click Find Now. The results of your new search appear in the item list. 
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Using the Find Results

Using the Find results shortcut menu, you can:

• Open an item’s metadata
• Open the file in the Search Results
• Copy and paste content
• Export an item
• Save attachments
• View previous versions of an item

Opening an Item’s Metadata

You can open the metadata of an item in the search results by right-clicking the item and selecting 
Open Item or selecting the item and selecting Open Item from the File menu. Only one item at a 
time can be opened from the list.

See “Opening Items” on page 30 for more information.

Opening the File in the Search Results

If the item is available (that is, items in a document library) and has an associated application on 
your computer, the Open File option is available in the context menu or the menu bar. If the item 
does not have an associated application, (for example, contact, announcement, calendar, and so on), 
the Open File option is not available.

You can also open the file from the Open Item metadata window. See “Opening the File” on 
page 31 for more information.

Copying and Pasting Content

You can copy SharePoint content from the search results list and paste them into a target. To copy 
and paste the whole list, under the Edit menu, select Select All or right-click the list and select 
Select All, then Copy.

See “Restoring SharePoint Data” on page 49 for more information.

Exporting an Item

The Export feature allows you to copy individual or multiple items from the Find in Sources 
window to a local or network drive destination. 

See “Exporting SharePoint Data” on page 45 for more information.

Saving Attachments

You can save any attachment of items that appear in the search results to the destination of your 
choice. See “Saving Attachments” on page 41 for more information.
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Previous Versions

By right-clicking a find result item, the context menu has Previous Versions enabled if that item has 
previous versions associated with it. If Previous Versions is disabled, there are no previous versions 
of that item. This option is also available in the Tools menu.

Figure 3-5. Previous versions of the item

When copying items, previous versions of the item are also copied.

See “Previous Versions in Source” on page 33 for more information.

Viewing Previous Search Results

You can click the Previous button multiple times to return to any previous search criteria and search 
results. This button becomes unavailable when there are no more previous results. 

To view previous search results

1. Perform at least two searches so the Previous button becomes available. 
2. Click Previous. The results of the previous search appear in the in the item list. 
3. You can now view the previous search, or you can modify the search criteria and conduct a 

new search. For information on specifying search criteria, see “Searching Sources” on 
page 36.

Clearing Fields and Results

If you click the Clear Fields button, all of the search criteria that you entered in the Find in Sources 
window are returned to the default settings. If you click the Clear Results button, all current and 
past search results are cleared. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Searching Within File Data or Attachments 

In the Find in Sources window, you can search the text of file data or attachments. The searching 
within a file or attachments feature supports Unicode text and is available for MDF, NDF, and LDF 
sources. Ontrack PowerControls supports Microsoft® Office documents and many other file types. 
For a list of supported file types, see the FAQs at www.ontrackpowercontrols.com/support/product-
support/.
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Note about the licensing agent: The “Agent for Advanced Searching for SharePoint” must be 
enabled in order to search file data or attachments. For more information, see “Enabling the 
Licensed Agents” on page 6. 

To search within files and/or attachments

1. In the Find in Sources window, select Item Data and File Data or Item Data, File Data, 
and Attachments from the Search in drop-down list.

2. Specify other desired search criteria. For more information, see “Searching Sources” on 
page 36.

3. Click Find Now. If Ontrack PowerControls matches a keyword or phrase in the text of the 
file or attachment, it will return a “Hit” just as it would if it found a keyword or phrase in the 
metadata of an item. 

Exceptions When Searching Within File Data or Attachments

Ontrack PowerControls for SharePoint does not search for the following items:

• Archive files (for example, .zip, .rar)
• Binary files (for example, .dll, .exe, .jpg) 
• Metadata associated with files (for example, author and company information in an .xls file)

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Restoring Items from the Find in Sources Window

The results of conducting a search appear in the item list in the Find in Sources window. You can 
restore the items in this list by dragging them or copying and pasting them into the target folder. 

You can also restore items by browsing in the main window and dragging and dropping or copying 
and pasting from the main window to the target. You do not need to search to restore items. For 
more information, see “Restoring SharePoint Data” on page 49. 
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Overview

You can export data from a SharePoint content source file to a local or network drive destination. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Guidelines for Exporting Items

The following guidelines will assist you in exporting items.

• The file name for an exported item is its leaf name. A duplicate leaf name creates a file with 
the same name but with an (x) appended to the filename: x = 1 for the first duplicate, x = 2 
for the next duplicate, and so on. 

• You must have access rights to the target location of the exported item.
• Single or multiple items can be exported from the list view
• Single or multiple items can be exported from the tree view. 
• Sub-items can be exported if the export is initiated from the tree view. This includes sites, 

lists, or folders underneath the selected tree node.
• You have the option to maintain the path to the item when the export is initiated from the list 

view. This creates a path including all the sites, lists, and folders up to and including the 
item name.

• When exporting a site, list, or folder from the tree view, a file system folder will be created 
based on the node name.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Exporting List Items 

The following instructions show you how to export a list item or multiple items from the source 
pane in the main window to a designated location. Items can be exported at a site, list, or folder 
level.

To export a list item

1. In the source pane, select the list item(s). 
2. Do one of the following:
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• On the Tools menu, select Export.
• On the toolbar, click the Export icon .
• Right-click the item, and on the shortcut menu, click Export.
• Enter Ctrl+P.

The Export Wizard appears.
3. To maintain the message path(s) of the exported list item(s), leave the default setting of the 

selected Maintain message path check box. Clear the check box if maintaining the 
message path is not desired. 

Note:  This option creates the path of all the sites, lists, and folders up to and including the 
item name.

4. In the Export To box, specify the location for the exported file.
5. Click Finish. The Export Progress window appears.

Note:  Attachments of items cannot be exported. To retrieve attachments, use the Save 
Attachments option.

Note:  If the same item is exported twice to the same location, a number is appended to the 
title to give it a unique name. For example, if Sample File.doc is exported to c:\export path\ 
and another file with the same name already exists, it is exported as c:\export path\Sample 
File(1).doc.

To export a site or list

1. In the source pane, select the site. 
2. Do one of the following:

• On the Tools menu, select Export.
• On the toolbar, click the Export icon .
• Right-click the site or list, and on the shortcut menu, click Export.
• Enter Ctrl+P.

The Export Wizard appears with the topmost node is selected.

Note:  If the site you are exporting contains more than one level of child nodes and items, 
only the first level appears in this list and can be exported.

3. In the Choose Export Items pane, select the node(s) to be exported. The following options 
are available:

• Leave every check box selected and export everything. Selecting the topmost node 
check box automatically selects all child nodes.

• Clear the child node check boxes using the Clear All button and export selected items 
only.

• Select the Choose All button to select all items in the tree.

Note:  Clearing a child node automatically clears the topmost node check box. However, 
individual child items can be selected and exported.

4. Leave the Export sub-nodes check box selected if you want them exported as well or clear 
it to exclude them.
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Note:  If the topmost node is selected under “Choose Export Items” and “Export 
sub-nodes” is selected, all child nodes (and their sub-nodes) will be exported regardless of 
their selection status.

5. Click Next. The second page of the Export Wizard appears.
6. Select the Export To destination and click Finish. The Export Progress report appears.

To export an item or folder

1. In the source pane, select the item or folder. 
2. Do one of the following:

• On the Tools menu, select Export.
• On the toolbar, click the Export icon .
• Right-click the item, and on the shortcut menu, click Export.
• Enter Ctrl+P.

The Export Wizard appears. If the item selected for export contains sub-items, the first 
page of the Export Wizard appears.
If the item selected does not contain any sub-items, the second page of the Export Wizard 
appears.

3. Select the Export To destination and click Finish. The Export Progress report appears.
This report can be printed or saved to your local hard drive.
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Overview

This section describes how to restore your Ontrack® PowerControls™ SharePoint content (list 
items, lists, folders, and sites) to a live SharePoint server and provides guidelines and important 
notes for restoring each type of SharePoint data to its desired destination.

SharePoint content items can be copied from multiple locations: the tree view list and folder, the 
source list, the Previous Versions window, and the Find in Sources search results list.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
General Guidelines for Restoring SharePoint Data

The following guidelines will assist you in restoring SharePoint data. See more specific guidelines 
for restoring each type of SharePoint data: list items, lists, folders, and sites.

• Lists can only be copied to sites.
• Folders can only be copied to lists or folders.
• List items can only be copied to lists or folders.
• Folders and items can only be copied to lists that support the correct content type.
• Duplicate source items cannot be copied unless the duplicate checking is turned off in 

Preferences. SharePoint does not allow duplicate items in the target. You will be prompted 
to overwrite duplicates.

• Security attributes including Author, Last Updated By, and Checked Out By may not match 
on the source and the target. If the information does not match, the author/editor 
information of the parent is inherited.

• Alerts associated with lists, folders, and items are not copied over as user accounts are not 
sychronized between the two sites.

• If an item is checked out in SharePoint, the copy function does not retain the checked out 
state of the item.

• Discussion items cannot be copied to the root of a Discussion.
• Discussion folders cannot be copied to other Discussion folders.
• Content Organizer rules for SharePoint 2010 will be copied. The copy will not enable the 

content organizer feature on the target site if it was not enabled. The rules will not work 
unless the content organizer feature is enabled.
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• Items copied to a site with Content Organizer rules in SharePoint 2010 will not by subjected 
to the content organizer rules on the target site.

• Document IDs are not preserved during a when restoring data. New document IDs will be 
created on the target.

• Items with legal holds placed on them in SharePoint 2010 do not preserve the legal hold 
information when restoring data. The new item will not have a legal hold after the data is 
restored.

• Items may have changes to the metadata changes after being copied; for example, a picture 
file may receive an EXIF header during the import.

• For some SharePoint 2007 list types, the Content Type column on the target may be empty 
after the copy.

• SharePoint 2010 source data cannot be copied to SharePoint 2007 targets.

Guidelines for Copying to Recurring and Non-Recurring Meeting Workspaces

The following guidelines will assist you in copying SharePoint data to recurring and non-recurring 
meeting workspaces.

• If copying items to a non-series library list (for example, Document Library, Slide Library, 
Picture Library, and so on):

• Only meeting instance folders can be copied to the root of the list, and the instance ID 
of the meeting instance folder being copied must match one of the instance IDs in the 
target meeting workspace. 

• No other folder or item can be copied to the root of the list.
• If copying to a non-series list other than a library list (for example, Announcements, Tasks, 

Contacts, and so on), the items being copied must match the meeting recurrence criteria on 
the target.

• If copying to a non-series discussion board:
• If copying a discussion topic, the recurrence criteria of the topic must match the target 

meeting recurrence criteria.
• If copying a discussion item, the item’s recurrence criteria must match the recurrence 

criteria of the discussion topic on the target.
• A target list containing series items has the same constraints as any other list (for example, 

content type match, checked out state, duplicate items, etc.).
• When copying a library list from a recurring meeting workspace into another site that is not 

a meeting workspace, the same constraints apply (for example, content type match, checked 
out state, duplicate items, etc.).

• Copying a list from a recurring meeting workspace to a non-recurring meeting workspace is 
not allowed unless the list is a series list.

• Copying a list from a non-recurring meeting workspace to a recurring meeting workspace is 
not allowed unless the list is a series list.

Agent for Content Transfer Service

The Ontrack PowerControls Agent for Content Transfer must be running on the SharePoint server 
in order to restore content to a specific site. The Ontrack PowerControls Agent for Content Transfer 
can be started or stopped using the Services management console or command line.
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To start the Ontrack PowerControls Agent for Content Transfer with the Services 
management console

1. Click Start, then select Run.
2. In the Run dialog box, type services.msc and click OK.
3. In the Services window, do one of the following:

• Select Ontrack PowerControls Agent for Content Transfer. On the General tab of the 
Ontrack PowerControls Agent for Content Transfer dialog box, click Start.

• Right-click Ontrack PowerControls Agent for Content Transfer and select Start.
• Select Ontrack PowerControls Agent for Content Transfer and click Start in the left 

column.
• Select Ontrack PowerControls Agent for Content Transfer and click Start Service in 

the tool bar.
4. Verify that the Ontrack PowerControls Agent for Content Transfer has started by refreshing 

the Services window.

To stop the Ontrack PowerControls Agent for Content Transfer with the Services 
management console

1. Click Start, then select Run.
2. In the Run dialog box, type services.msc and click OK.
3. In the Services window, do one of the following:

• Double-click Ontrack PowerControls Agent for Content Transfer. On the General tab 
of the Ontrack PowerControls Agent for Content Transfer dialog box, click Stop.

• Right-click Ontrack PowerControls Agent for Content Transfer and select Stop.
• Select Ontrack PowerControls Agent for Content Transfer and click Stop in the left 

column.
• Select Ontrack PowerControls Agent for Content Transfer and click Stop Service in 

the tool bar.
4. Verify that the Ontrack PowerControls Agent for Content Transfer has started by refreshing 

the Services window.

To start the Ontrack PowerControls Agent for Content Transfer with the command line

1. Click Start, then select Run.
2. In the Run dialog box, type cmd and click OK.
3. In the command line, type net start “Ontrack PowerControls Agent for Content 

Transfer” and press Enter.
4. Type net start to view a list of services running and verify that the Ontrack PowerControls 

Agent for Content Transfer is included.

To stop the Ontrack PowerControls Agent for Content Transfer with the command line

1. Click Start, then select Run.
2. In the Run dialog box, type cmd and click OK.
3. In the command line, type net stop “Ontrack PowerControls Agent for Content 

Transfer” and press Enter.
4. Type net start to view a list of services running and verify that the Ontrack PowerControls 

Agent for Content Transfer is absent.
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Duplicate Checking

When copying and pasting SharePoint data, two different types of duplicate checking are 
performed:

• Lists, Folders, and Document Library files: Duplicate checking checks the item’s 
filename or Leaf Name. If the target list contains an item that has the same name, you are 
prompted with the option to overwrite.

• Items: Items are flagged as duplicates if they are copied from a source that is the backup of 
the target and you are attempting to copy the item to the same location.

If a list is copied to another site with the same list, the contents of the source are added to the target 
list. The properties of the source list does not overwrite the target list.

Figure 5-1. Leaf Name is used for checking duplicates in Lists, Folders, and Document Library 
files

If a duplicate is found, an overwrite confirmation message appears.

Feature Not Found

The Feature Not Found dialog box appears if a feature used by a source site is not found on the 
target site; for example, when copying from a previous version of SharePoint to a more recent 
version, the feature may longer be available. 

If a feature is not found, your options are as follows:

If you want to: Click this:

Continue copying the site without the 
missing feature and be alerted if other 
missing features are detected during this 
copy session.

Yes

Continue copying the site without any 
missing features.

Yes to All

Skip the copying of the site and be alerted 
if another missing feature is found while 
copying another site during this copy 
session.

No
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Overwrite Confirmation

The Overwrite Confirmation dialog box appears if duplicate items are found during the copy/paste 
process and the “Check for duplicates during copy” option is selected on the Preferences dialog box 
(Edit menu > Preferences command). 

If a duplicate is found, your options are as follows:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Restore SharePoint Data Using Two Different Methods

In Ontrack PowerControls for SharePoint, you can restore data to the target pane by using Copy-
Paste or Drag-and-Drop.

Source items can be dragged and dropped to the target but the copy and paste rules apply. If an item 
does not complete the copy process, the Copy Progress window provides the specific reason unless 
it is an unexpected error.

Skip the copying of all sites with missing 
features during this copy session.

No to All

Close the Overwrite Confirmation dialog 
box and end the copy session

Cancel

If you want to: Click this:

Overwrite the duplicate item. Overwriting 
the items causes the existing duplicate item 
to be deleted and the new item copied in its 
place.

Yes

Overwrite all duplicate items Yes to All

Rename the duplicate item Rename

Rename all duplicate items Rename All

Avoid overwriting or renaming the 
duplicate item. Clicking No moves you to 
the next times and ignores the overwrite 
message.

No

Avoid overwriting or renaming any 
duplicate items

No to All

Close the Overwrite Confirmation dialog 
box and end the copy/paste process

Cancel

If you want to: Click this:
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To copy an item from the source pane or Find in Sources window

1. In the source pane or Find in Sources window, select items. 
2. Do one of the following:

• On the Edit menu, select Copy.
• Right-click the selected item(s), and on the shortcut menu, click Copy.
• Click the Copy icon  on the toolbar.
• Press Ctrl+C (Copy).

To paste an item to the target pane

1. In the target pane, select destination.
2. Do one of the following:

• On the Edit menu, click Paste.
• Right-click the selected item, and on the shortcut menu, click Paste. 
• Click the Paste icon  on the toolbar.
• Press Ctrl+V (Paste).

To use drag-and-drop 

• Drag an item from the source pane into a folder or site root node in the target pane. 
Dragging and dropping achieves the same results as copying and pasting.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Restoring Your SharePoint Data

This section provides examples of restoring sites, lists, folders, and items to the desired destination. 
In each case, it provides guidelines for restoring data. If you copy a site, list, folder, or item from 
the source pane and paste it to any target destination, Ontrack PowerControls for SharePoint 
preserves the directory structure of all restored items. See specific guidelines under each data type 
being restored.

Restoring Items

The following instructions show you how to restore individual items to a folder in a target 
SharePoint server by using Copy-Paste or Drag-and-Drop.

Guidelines for Restoring Items

• You can copy from the items list in the source pane or the Find in Sources window. 
• You can use drag-and-drop or Copy-Paste to restore individual items to a folder or list in the 

target pane. 
• You cannot use drag-and-drop or Copy-Paste to restore individual items to a SharePoint 

server root node or site. 
• Using drag-and-drop or Copy-Paste to restore individual items does not preserve the 

directory structure of the restored items. 

To restore items with Copy-Paste

1. In the source pane or Find in Sources window, copy the item from the item list.
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2. In the target pane, paste the items into a folder or list in the target SharePoint server. 
3. In the Copy Progress window, verify that your items were successfully copied. You can 

also print or save the copy report by doing one of the following.
• Click Print to print the copy report.
• Click Save to save the copy report as a text file.

4. In the Copy Progress window, click Close to return to the main window. 

Results of Restoring Items with Copy-Paste

All unduplicated items appear in the target folder.

Restoring a Folder 

The following instructions show you how to restore a folder to any target destination by using 
Copy-Paste or drag-and-drop. 

Guidelines for Restoring a Folder

• You can use drag-and-drop or Copy-Paste to restore a folder to a target SharePoint server 
list or folder. If the folder does not exist in the target destination, it is created. 

• You cannot restore a folder to a SharePoint Server root node.
• You cannot restore a folder to a site node.

To restore a folder

1. In the source pane, copy a folder.
2. In the target pane, paste the folder into a folder or list.
3. In the Copy Progress window, verify your results to make sure your items from all folders 

were copied to the target destination. You can also print or save the copy report by doing 
one of the following.

• Click Print to print the copy report.
• Click Save to save the copy report as a text file.

4. In the Copy Progress window, click Close to return to the main window. 

Results of Restoring a Folder

All unduplicated items in the folder are restored and their directory structure is preserved. If the 
folder does not exist in the target destination, it is created. 

Note:  No folder is created because the copied folder already exists in the target site.

Restoring a List

The following instructions show you how to restore a list to any target destination by using Copy-
Paste or drag-and-drop. 

Guidelines for Restoring a List

• You can use drag-and-drop or Copy-Paste to restore a list to a target SharePoint server site. 
• You cannot restore a list to a SharePoint Server root node.
• You cannot restore a list to a folder or another list.
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To restore a list

1. In the source pane, copy a list.
2. In the target pane, paste the list into a site.
3. In the Copy Progress window, verify your results to make sure that your lists were copied 

to the target destination. You can also print or save the copy report by doing one of the 
following.

• Click Print to print the copy report.
• Click Save to save the copy report as a text file.

4. In the Copy Progress window, click Close to return to the main window. 

Results of Restoring a List

All unduplicated items in the list are restored and their directory structure is preserved. 

Restoring a Site

The following instructions show you how to restore a site to a target destination by using Copy-
Paste or drag-and-drop.

Guidelines for Restoring a site

• The following SharePoint 2010 database sites are not supported:
• Assets Web Database
• Charitable Contributions Web
• Contact Web Database
• Issues Web Database
• Project Web Database

• A Site Collection with the Office SharePoint Server Publishing Infrastructure Site feature is 
not supported when restoring SharePoint 2007 to SharePoint 2010.

• Sites can only be copied to other target sites or a target data store root. If the site is pasted 
into the target data store root, you will be required to select the web application to copy the 
site. See Step 3 under “To restore a site.”

• If a site collection source site that does not contain a Leaf Name is copied as a sub-site in 
the target, you will be required to supply the Leaf Name before the copy can continue. 

• If the site previously exists on the target, only the children of the site are copied.
• Sites dependent on specific SharePoint features will not function if the features are not 

enabled on the target SharePoint server.
• Site Quota’s for parent-level sites will not be copied.
• Site Quick Links are added at the end of a site copy. Therefore, some Quick Links may not 

be copied if you cancel a site copy operation before it completes. Since the Quick Links 
point to lists or sub-sites in a site, a given list or site may not have been created before you 
cancelled the operation.

• For site and list permissions, if a matching group exists on the target, the site or list will use 
the target group’s permission levels and users associated with that group. If the target group 
has different users or permissions levels than the source, the site or list will now use the 
target’s permissions.

• Only Site Collection sites can be copied to a target data store.
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• Quick Links for sites that contain a Pages List (Publishing Site, Personalization Site, etc.) 
may appear differently after a site copy. Once a page type document (Page, Article Page, 
Master Page, etc.) is checked into a pages site, a Quick Link is added. Since Ontrack 
PowerControls for SharePoint does not copy the checked out state, items are assumed to be 
checked in. Therefore, additional Quick Links may appear after the site has been copied.

• During any copy operation (site, list, folder, or item) the target location’s parent Site 
Collection is checked for any write locks that are set. If the Site Collection has a “Adding 
content prevented,” “Read-only,” or “No access” set, then no data can be copied to any 
location within the Site Collection. These locks can be set via Application 
Management>Site Collection Quotas and Locks in the SharePoint admin tool. 

• When a Site Collection is copied from one domain to another, the user login information 
stored in the database may not be valid on the new domain.

Important:  If no user login domains match between the source and target, you will have to use the 
SharePoint Central Administration tool to reassign site ownership since none of the copied logins 
will work.

Guidelines for Restoring Workflows

The following guidelines pertain to SharePoint Workflows.

• Started Workflows are not copied for an item. This includes the history and associated tasks 
for the Workflow.

• Workflows that are set up for a list are not copied. The history and task Lists are copied but 
the associations are not automatically setup. Manual setup is possible.

Guidelines for Restoring WebParts

The following guidelines pertain to SharePoint WebParts.

• Items that contain WebParts, which point to other lists within the site, may not function 
correctly if you cancel a site copy operation before it completes.

• All WebParts are copied to the target, but they may not function properly after they have 
been copied. Some WebParts store the path and IDs of lists and items they are pointing to. 
Since new IDs are generated and allow you to copy data anywhere, the IDs and paths may 
no longer be valid after the WebPart is copied.

• If a WebPart is copied to same target location as the source, most WebParts will function 
properly since the paths are the same. 

To restore a site

1. In the source pane, copy a site.
2. Paste the site into the desired location of the target pane.
3. If the source site is pasted into the root node of a target, the Select Site Collection URL 

dialog box appears. Select the web application and site collection URL and enter the 
primary site collection administrator information to copy the site.
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Figure 5-2. Select Site Collection URL dialog box

• Select a Web Application: Select the web applications that are contained in the target 
server. 

• URL: View the web application URL label. This is the base URL where the new site 
collection will be located

• Managed Path: Select the managed paths that reside in the target server for the 
selected Web Application. The contents of this list changes based on the Web 
Application selected. If you want to have a specific URL other than “/site/” for a Site 
Collection, you need to select a managed path. 

Selecting a managed path with Explicit Inclusion allows a single SharePoint site to be 
created for the given URL, so nothing more is required. If you select a managed path 
with Explicit Inclusion, the Site Name field will be disabled. Note: This option may not 
be available if a site has already been created for the given path. 
Example: http://servername:portnumber/Sales

Selecting a managed path with Wildcard Inclusion allows you to create further Site 
Collections under the specified managed path. When this option is selected, the Site 
Name field is enabled, allowing you to create the site name which is appended on the 
path URL. In this case you must specify a Site Name for the new site collection.
Example: http://servername:portnumber/Manufacturing/Group1 and 
http://servername:portnumber/Manufacturing/Group 2.

• Site Name: If this box is enabled, enter a site name for additional web site addresses. 

Note:  The following characters cannot be used in the site name:  " # % & * : < > ? \ / { } ~.  
The site name also cannot start with an underscore character “_”.

• Primary Site Collection Administrator (domain\username): Enter the domain and 
username of the user that will be the primary site collection administrator. This 
username must be in the Domain\Username format. Ontrack PowerControls for 
SharePoint will use this username to connect to the new site collection after it has been 
created.
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• Password: Enter the password for the primary site collection administrator. The 
username and password are validated for the primary site collection administrator, so 
the site collection will not be created until the correct password is supplied for the site 
collection administration.

4. Click OK. The source site is copied into the target site.
5. In the Copy Progress window, verify your results to ensure that your sites were copied to 

the target destination. You can also print or save the copy report by doing one of the 
following.

• Click Print to print the copy report.
• Click Save to save the copy report as a text file.

6. In the Copy Progress window, click Close to return to the main window. 

About the Copy Progress Window

Each time you attempt to restore items to the target pane, the Copy Progress window appears. This 
window displays the following information about the copy operation: 

• Source, Source Path, Target, and Target Path
• Time of copy operation
• Number of items, lists, folders, and sites
• Warnings and errors, if any
• Number of items successfully copied

Figure 5-3. Copy Progress Window

Note:  If you do not have full access rights to the target location, Ontrack PowerControls for 
SharePoint is unable to complete the copy process. The target location must also have enough 
space for the data and it must support the content type of the source data.

PRINT COPY PROGRESS DATA AS A REPORT

When the copy progress is complete, you have the option to print the report which records any 
interruptions in the copy progress or any errors that occurred. This report also tells you how many 
items successfully copied, how many did not copy, and how many errors occurred.
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SAVE COPY PROGRESS DATA AS A REPORT

The Copy Progress report can be saved as a text file to the destination of your choice by clicking 
the Save button.
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Term Description

Data Store A unified collection of folders, items, and lists contained in a single 
storage medium. 

Data Wizard The first time you start Ontrack® PowerControls™, the Data 
Wizard launches. The Data Wizard guides you through the loading 
of MDF, NDF, and LDF files into Ontrack PowerControls, and 
shows you how to specify the target SharePoint server. 

Document Library A folder where a collection of files is stored and the files often use 
the same template.

Duplicate Checking A process detecting duplicate items based on filenames which 
provides you the option to overwrite the item.

Explicit Inclusions Selected in Managed Paths, explicit inclusions includes only the 
specific path that you set. For example, use explicit inclusions if 
you want SharePoint to manage a specific path, such as /portal, but 
not any possible sites below it, such as /portal/teamshare.

GUID Globally Unique Identifier. Each SharePoint database has a separate 
GUID.

Item An entry in a list or folder (posts, pictures, links, comments, etc.) 
contained within a list or a folder in the source or target panes.

List A web site component that stores and displays information that 
users can add to, copy, and search in Ontrack PowerControls for 
SharePoint.

Log Files Transaction log files (.ldf files) are history files recording server 
activity. These files are useful in restoring and backing up 
SharePoint data.

Managed Paths Managed Paths allow you to manage two categories of paths: 
included and excluded paths when creating a top-level web site or a 
specific URL. An included path indicates that it is a SharePoint-
created path. An excluded path indicates that a different application 
manages the path and was created by the user. Included paths can be 
further broken down into the following two types: Explicit 
Inclusions and Wildcard Inclusion.

MDF, NDF, and LDF 
Files

SharePoint content database files used as the source. The three files 
work as a collection to comprise a single content database. You 
must have one MDF, one or more LDF, and optionally zero or more 
NDF files.

Metadata Data about data. For example, the title, subject, author, and size of a 
file constitute metadata about the file.
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Non-series List A non-series list is a special list created for meeting workspaces and 
have specific instances of the meeting assigned to the list.

Previous Versions Items, such as documents and pictures, create a backup copy 
whenever it is saved to the library in SharePoint. These previous 
versions are accessible in Ontrack PowerControls for SharePoint.

Series List A series list provides a way to have a regular list in a recurring 
meeting workspace. A series list shows all of the items for all 
occurrences of a meeting.

Shortcut Menu This menu is accessed by right-clicking on an item.

Site A group of related web pages that generally cover one or more lists 
and folders.

Site Collection A set of web sites that have the same owner and share 
administration settings. Each site collection contains a top-level 
web site and can contain one or more subsites.

Source This is the Microsoft® Office SharePoint® Server content database 
stored on a SharePoint server from which folders and lists are 
copied. The source is read-only, so items cannot be copied into, 
deleted from, or changed in the source.

Target This is the data store to which lists, folders, and items are copied. 
The target is read-write allowing items to be added. 

Wildcard Inclusion Selected in Managed Paths, wildcard inclusion includes any sites 
below the path that you set, so you do not have to add them 
individually. This is the type of inclusion to use for specific site 
names that are appended to the URL, when you want to be able to 
create top-level web sites underneath a specific path, such as /sites.

Term Description
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